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Have	you	ever	wished	you	could	change	the	color	of	clothing	in	Photoshop?		For	example,	it	would	be	so	handy	for	an	eCommerce	store	owner	to	take	a	picture	of	a	shirt	and	change	the	t-shirt	color	in	Photoshop	to	show	every	color	they	offer.	Then	they	don’t	have	to	buy	and	photograph	them	one	by	one.		Hello!	I’m	Cara	and	while	you	might	have
thought	that	this	feat	would	be	complicated,	it’s	actually	super	simple.	Online	retailers	do	it	all	the	time	to	reduce	their	workload	and	I’m	about	to	share	the	secret	with	you.	So	let’s	dive	into	how	to	change	clothes	color	in	Photoshop.	You	can	use	the	same	method	to	change	the	color	of	the	t-shirt	or	any	other	clothing.	2	Essential	Steps	to	Change
Clothing	Color	in	Photoshop	Although	there	are	different	ways	to	change	colors	in	Photoshop,	the	easiest	way	to	change	the	color	of	clothes	would	be	to	use	the	Color	Range	tool	to	select	the	object	(clothing)	and	adjust	its	hue/saturation.				Step	1:	Select	the	Clothing	You	can	use	any	selection	method	to	select	the	clothing.	Choose	whichever	is	most
comfortable	or	will	be	the	easiest	for	your	particular	photo.	In	most	cases	for	product	photography,	the	subject	will	be	standing	against	a	white	or	plain	background.	This	makes	the	Color	Range	selection	method	a	good	choice.		This	tool	allows	you	to	choose	a	color	in	the	image	and	Photoshop	will	automatically	select	all	pixels	that	are	the	same	or
similar	color.		Go	to	Select	in	the	menu	bar	at	the	top	and	choose	Color	Range.	In	the	box	that	opens,	you	have	a	few	options	for	selecting	the	color.	Bring	the	Fuzziness	up	so	Photoshop	will	select	a	larger	color	range	(more	shades	of	the	same	color).	Bring	it	down	if	you	want	to	restrict	the	color	range.		Set	the	Eyedropper	tool	to	the	icon	with	the	+
sign.	This	means	that	every	time	you	click	on	the	image,	the	color	of	the	pixel	you	click	on	is	added	to	the	range.	You	can	use	the	one	with	the	–	(minus)	sign	to	subtract	parts	you	don’t	want.		In	the	preview	box,	everything	that	is	white	will	be	selected	and	black	will	not	be	selected.	The	tool	has	picked	up	a	bit	of	the	background,	but	that’s	okay,	we
can	clean	it	up	easily.	Press	OK.	Now	choose	the	Quick	Selection	Tool	from	the	toolbar	on	the	left.		Click	and	drag	over	any	areas	that	have	been	missed.	Hold	the	Alt	or	Option	key	while	dragging	to	remove	areas	that	shouldn’t	be	selected.	Make	sure	to	remove	any	bits	of	the	background	that	have	been	selected.		Take	your	time.	Your	selection	has	to
be	perfect	or	the	color	transformation	will	end	up	looking	fake.		Step	2:	Add	a	Hue/Saturation	Layer	Click	the	Adjustment	Layer	icon	at	the	bottom	of	the	Layers	panel.	It	looks	like	a	half-filled	circle.	Choose	Hue/Saturation	from	the	menu.		Now,	it’s	simply	a	matter	of	adjusting	the	sliders	to	get	the	color	you	want.	The	Hue	slider	changes	the	base
color	and	you	can	use	the	Saturation	slider	to	tweak	it.		The	Lightness	slider	may	also	be	helpful	in	some	cases	but	take	care.	Move	it	too	much	and	it’s	obvious	that	you’ve	brightened	or	darkened	the	color	too	much.		With	these	settings,	I’ve	turned	her	pretty	blue	dress	into	a	green	one.		Or	I	can	bring	it	over	this	way	to	give	her	a	red	one.	Pretty	cool
how	that	works,	right?	Curious	about	what	else	you	can	do	with	color	in	Photoshop?	Check	out	how	to	key	out	a	certain	color	here!	About	Cara	Koch	Changing	clothing	color	in	Photoshop	seems	like	a	tricky	task	because	of	the	unevenness	of	clothes.	The	method	you	use	to	change	the	color	will	depend	on	the	color	of	the	clothes	and	the	various
shadows	and	tones	that	occur	from	their	creases.	Black	and	white	clothing	are	the	trickiest	to	change	because	they	are	not	actual	colors,	while	clothing	with	colors	can	be	adjusted	using	hues.	In	this	tutorial,	you’ll	learn	how	to	change	both	colored,	white,	and	black	clothing	with	ease!	Start	by	adding	a	Hue/Saturation	Adjustment	Layer	by	clicking	the
Hue/Saturation	option	in	the	Adjustments	Panel.		Once	you	have	created	the	layer,	open	the	Properties	Panel.	If	this	panel	is	not	visible,	head	to	Window	>	Properties.	In	the	panel,	you	can	select	the	color	you	want	to	change	in	two	ways.	The	first	is	to	choose	a	color	channel	to	target	by	clicking	on	the	drop-down	menu	that	reads	“Master”	by	default.
However,	for	a	more	precise	selection,	select	the	icon	showing	a	finger	with	two	arrows	on	either	side.	Then	click	on	the	color	in	the	image	you	want	to	select.	For	this	photo,	I	will	click	on	his	shirt.	With	the	color	of	the	shirt	selected,	adjust	the	Hue,	Saturation,	and	Lightness	sliders	to	the	color	and	tone	you	want	the	shirt	to	be.		The	shirt	will	change
color	as	you	move	the	sliders,	making	it	easy	to	find	the	right	updated	color.	You	will	now	have	successfully	changed	the	color	of	the	shirt.	Before	After	When	the	image	is	open,	use	any	selection	tool	to	select	the	white	shirt.	Once	the	shirt	is	selected,	add	a	color	fill	layer	by	selecting	the	new	fill	or	adjustment	layer	icon	at	the	bottom	of	the	Layers
Panel	and	selecting	Solid	Color	from	the	menu.	The	color	picker	will	automatically	open,	where	you	can	select	the	color	you	want	the	shirt	to	be.	Click	on	the	color	of	your	choice	in	the	panel	on	the	left	or	add	a	specific	color	value	in	the	color	modes	on	the	right.	Pressing	OK	in	the	color	picker,	you	will	notice	the	color	of	the	white	shirt	has	changed.
To	blend	the	new	color	into	the	shirt,	you	need	to	change	the	blend	mode	of	the	new	fill	layer.	To	do	this,	make	sure	the	new	fill	layer	is	selected	and	click	on	the	layer	blending	mode	at	the	top	of	the	Layers	Panel.	Then,	select	Multiply	from	the	options	in	the	drop-down	menu.		Once	you	select	Multiply,	you	will	notice	that	the	new	color	has	blended
into	the	shirt	and	looks	a	lot	more	natural.	To	fix	areas	that	still	show	the	white	shirt,	select	the	layer	mask	of	the	fill	layer,	then	select	the	Brush	Tool	from	the	Toolbar	(B).	Then,	make	sure	the	foreground	color	is	set	to	white.	Note:	When	painting	over	a	layer	mask,	white	hides	the	original	layer,	whereas	black	reveals	the	original	layer.	Resize	the
brush	according	to	the	size	of	the	area	you	need	to	touch	up.	Brush	over	the	areas	of	the	image	you	need	to	touch	up,	and	you	will	have	successfully	changed	the	shirt	color.	Before	After	When	the	image	is	open,	use	any	selection	tool	to	select	the	black	shirt.	Once	the	shirt	is	selected,	create	a	Hue/Saturation	Adjustment	Layer	by	clicking	on	the
option	in	the	Adjustments	Panel.	When	the	Hue/Saturation	Properties	Panel	opens,	your	selection	will	automatically	be	applied	to	the	mask.		Now	enable	the	Colorize	option.	The	colorize	option	adds	a	tinted	overlay	to	the	selection,	allowing	you	to	add	a	general	hue	and	saturation	to	the	area.	Now,	when	you	adjust	the	Hue,	Saturation,	and	Lightness
slider,	the	shirt	will	change	color.	Remember	to	only	slightly	adjust	the	sliders	because	changing	the	color	too	much	will	look	unnatural.	Adjust	the	sliders	until	you	have	a	natural-looking	color	added	to	the	shirt.	Since	the	original	shirt	is	black,	we	can	only	realistically	add	dark	colors	in	this	instance.	To	add	a	Curves	Adjustment	Layer,	select	the
Curves	option	from	the	Adjustments	Panel.	Once	the	Curves	layer	is	added,	you	need	to	add	a	clipping	mask	to	apply	the	new	adjustment	to	the	Hue/Saturation	adjustment	layer	and	not	the	entire	image.	To	add	a	clipping	mask,	right-click	(Win)	or	Control	+	click	(Mac)	on	the	Curves	layer	and	select	Create	Clipping	Mask.	In	the	Curves	Properties
window,	modify	the	curve	to	lift	the	shadows	and	refine	the	highlights.	In	a	nutshell,	dragging	up	the	curve	will	lighten,	while	dragging	down	will	darken.	In	this	case,	I	will	add	an	anchor	point	in	the	shadows	and	highlights	and	drag	up	to	lighten	the	shirt.	To	fix	areas	where	the	color	was	added	where	it	shouldn’t	be,	double-click	on	the	Adjustment
layer	in	your	Layers	Panel.	This	will	open	up	the	Layer	Style	Panel.	Move	down	to	the	last	section	and	ensure	that	the	Blend	If	option	is	set	to	Gray.	Then,	use	the	bottom	Underlying	Layer	slider	and	drag	the	highlight	point	to	the	left	to	remove	the	adjustment	from	the	highlights	(aka	the	blonde	hair).	Since	the	shirt	is	dark	and	the	hair	is	light,	this
makes	it	easy	to	remove	the	adjustment	from	the	hair.	Adjust	the	slider	as	much	as	you	need	until	the	hair	is	back	to	its	original	color.	Then	click	OK	when	you	are	done.	You	will	now	have	an	image	where	the	black	shirt	has	been	changed	to	a	dark	color	without	the	hair	on	the	shirt	affected	by	the	color	change.	Before	After	Now,	with	these	different
techniques,	you	can	easily	change	the	color	of	clothing	regardless	of	the	environment	your	subjects	are	in.	Now	that	you’ve	changed	the	color	of	your	subject’s	clothes,	you	may	want	to	touch	up	some	of	the	clothing	wrinkles,	too.	I	share	exactly	how	to	do	that	in	this	next	tutorial	on	how	to	remove	wrinkles	from	clothing	in	Photoshop.	Happy	editing!
Any	type	of	photographer	needs	a	good	photo	editing	software	to	enhance	the	beauty	of	the	raw	photograph.	There	are	lots	of	photo	editing	software	…	Read	More	→	The	proverb	says	“a	picture	worth	thousand	words”	and	when	e-commerce	we	say	a	picture	worth	thousand	visitors.	Because	a	picture	can	create	a	great	…	Read	More	→	The	latest
trend	in	the	marketing	of	products	using	Photoshop	is	to,	“Change	the	background”.	Literally,	everyone	is	selling	their	products	online	by	posting	attractive	…	Read	More	→	Being	able	to	realistically	change	the	color	of	something	in	Photoshop	is	an	essential	skill,	especially	when	working	with	images	of	clothing,	fashion,	or	products.	Fortunately,	the
tools	and	techniques	you’ll	need	to	work	with	color	are	easy	to	use	and	master.	Using	basic	selections,	Layer	Masks,	and	Hue/Saturation	and	Curves	Adjustment	Layers,	you’ll	be	able	to	change	the	color	of	anything	in	a	matter	of	minutes.	Making	a	Selection	Like	many	other	Photoshop	techniques,	the	color	change	workflow	starts	with	a	selection.
Selections	allow	us	to	do	a	number	of	things,	like	target	a	specific	area	or	object	in	a	photo	that	we	want	to	edit.	Since	we’re	trying	to	change	the	color	of	the	subject’s	clothing,	we	need	to	make	a	selection	of	the	clothing	so	that	we	can	change	the	color	without	affecting	anything	else	in	the	image.	There	are	a	ton	of	ways	to	make	selections	in
Photoshop–some	are	quick	and	easy,	and	others	require	a	little	more	time	and	attention.	Since	the	image	we’re	working	with	has	a	relatively	simple	background,	we’re	going	to	focus	on	the	quicker,	automated	tools	to	get	the	job	done.	Keep	in	mind	that	selections	(and	Layer	Masks)	are	things	that	evolve	and	change	throughout	an	edit.	As	you’ll	see
later,	an	original	selection	might	need	to	be	refined	later	in	the	editing	process	as	we	notice	areas	that	the	quick	selection	tools	might	have	missed.	To	create	a	quick,	initial	selection,	open	the	Select	menu	and	choose	the	Subject	option.	Photoshop	will	try	to	automatically	identify	and	create	a	selection	around	the	main	subject	in	the	photo.	With	this
particular	image,	Select	Subject	does	a	nice	job	of	accurately	identifying	the	subject	and	selecting	them.	Since	we’re	only	trying	to	edit	the	clothing,	we’ll	eventually	need	to	remove	the	subject’s	face,	skin,	and	hair	from	the	selection,	but	that	will	be	easier	once	we’ve	converted	the	selection	into	a	Layer	Mask.	Creating	a	Layer	Mask	from	a	Selection
Now	that	we	have	an	active	selection,	it’s	easy	to	turn	it	into	a	Layer	Mask.	Since	we’re	focusing	on	color	change,	the	main	tool	we’ll	be	using	is	a	Hue/Saturation	Adjustment	Layer.	Whenever	you	have	an	active	selection	while	creating	a	new	Adjustment	Layer,	Photoshop	automatically	loads	that	selection	as	the	Layer	Mask	of	the	Adjustment	Layer.
With	the	selection	active,	simply	create	a	new	Hue/Saturation	Adjustment	Layer	above	the	image	in	the	Layers	Panel.	Photoshop	will	apply	the	selection	to	the	Layer	Mask.	We’re	just	about	ready	to	start	adjusting	the	color	of	the	clothing,	but	first	we	need	to	remove	the	subject’s	face,	skin,	and	hair	from	the	Layer	Mask	so	that	they’re	not	affected	by
the	Hue/Saturation	Adjustment	Layer.	Refining	the	Layer	Mask	Layer	Masks	are	very	easy	to	edit	and	refine	over	time.	The	most	important	thing	to	remember	is	that	a	Layer	Mask	simply	defines	where	its	associated	Layer	will	be	visible.	White	means	that	that	part	of	the	Layer	will	be	visible	(in	this	case,	the	subject),	and	black	means	that	that	part	of
the	Layer	will	be	invisible	(in	this	case,	the	background).	Since	we	want	to	isolate	the	clothing,	only	the	clothing	should	appear	in	white	on	the	Layer	Mask.	Try	using	the	Quick	Selection	Tool	to	select	the	subject’s	face	and	hair.	Once	you	have	an	active	selection,	click	on	the	Layer	Mask	of	the	Hue/Saturation	Adjustment	Layer,	and	then	fill	the
selection	with	black	by	opening	the	Edit	menu	and	clicking	on	the	Fill	option.	Repeat	this	process	for	any	other	areas	of	the	subject’s	skin	and	hair.	Once	you’re	done,	only	the	clothing	should	be	visible	in	white	on	the	Layer	Mask.	Changing	the	Color	Now	that	the	clothing	is	separated	from	the	rest	of	the	image,	we’re	ready	to	adjust	the	color!	In
many	cases,	a	single	Hue/Saturation	Adjustment	Layer	will	do	the	trick,	but	occasionally	an	additional	Curves	Adjustment	Layer	can	help	bring	back	detail	in	the	highlights	and	shadows	(most	useful	when	changing	the	color	to	black	or	white).	Since	it’s	handy	to	have	a	Curves	Adjustment	available,	let’s	set	the	project	up	so	that	we	can	use	both.
We’re	going	to	need	the	same	Layer	Mask	for	both	the	Hue/Saturation	Adjustment	Layer	and	for	the	Curves	Adjustment	Layer.	The	easiest	way	to	do	this,	and	stay	organized,	is	to	put	the	Hue/Saturation	Adjustment	Layer	into	a	Group	by	selecting	it	and	then	hitting	CTRL	or	CMD	+	G.	Then	click	and	drag	the	Layer	Mask	we	created	up	to	the	Group.
Now	everything	we	place	into	this	Group	will	be	defined	by	the	Layer	Mask	of	the	Group.	Create	a	Curves	Adjustment	Layer	and	place	it	into	the	Group	with	the	Hue/Saturation	Adjustment	Layer.	Working	with	Hue/Saturation	Adjustment	Layers	To	change	the	color	of	the	clothing,	double-click	on	the	Hue/Saturation	Adjustment	Layer	to	open	the
dialog.	Make	sure	to	check	the	Colorize	box	just	below	the	three	main	sliders.	Then	adjust	the	sliders	to	change	the	color	of	the	clothing!	While	changing	the	color,	you	may	notice	other	areas	you	might	have	missed	while	creating	the	selection	and	Layer	Mask.	You	can	use	a	variety	of	selection	tools,	or	just	the	Brush	Tool	set	to	black	or	white,	to
further	refine	the	Layer	Mask.	Changing	the	Color	to	Black	or	White	Our	initial	color	change	turned	the	clothing	from	lavender	to	green,	which	was	pretty	easy.	But	what	if	we	wanted	to	change	the	clothing	to	black	or	white?	Changing	the	color	of	something	to	black	or	white	can	be	tricky	as	it’s	easy	to	lose	important	details	in	texture	or	in	the
highlight	and	shadow	information.	That’s	where	the	Curves	Adjustment	Layer	can	help.	For	example,	let’s	try	changing	the	color	to	black.	Drag	the	Saturation	slider	all	the	way	to	the	left.	Then,	drag	the	Lightness	slider	in	the	Hue/Saturation	Adjustment	Layer	dialog	to	near	black.	Don’t	drag	it	all	the	way	to	the	left,	as	you	will	lose	almost	all	of	the
detail	you’ll	need	to	make	it	look	realistic.	Then,	double-click	on	the	Curves	Adjustment	Layer	dialog.	Make	the	darks	a	little	bit	darker,	and	the	highlights	a	little	bit	brighter.	This	will	help	to	recover	some	of	the	original	highlight	and	shadow	information,	creating	a	much	more	realistic	effect.	You	can	follow	the	same	steps	if	you	want	to	change	the
color	to	white.	The	only	difference	being	that	you	want	to	reverse	the	Curves	adjustments,	instead	making	the	highlights	a	little	bit	darker	and	the	shadows	a	bit	brighter.	Creating	a	more	cohesive	color	palette	in	an	image	can	make	for	a	more	pleasing	and	impactful	photograph.	Take,	for	example,	a	photo	of	colorful	clothing	in	front	of	an	equally
colorful	background.	The	colors	are	what	make	this	image	pop,	but	what	if	we	could	take	it	a	step	further	and	match	the	color	of	the	subject’s	clothing	to	more	closely	match	the	mural	in	the	background?	Let’s	give	it	as	try!	Hue/Saturation	Adjustment	Layers	We	often	talk	about	the	power	of	Adjustment	Layers	in	Photoshop.	And	when	you	want	to
change	the	color	of	anything,	there’s	no	better	tool	than	the	Hue/Saturation	Adjustment	Layer.	Create	a	Hue/Saturation	Adjustment	Layer	above	the	background	image.	Notice	that	there	are	a	variety	of	tools	that	allow	us	to	define	color	ranges	that	we	want	to	affect.	In	this	particular	example,	we	want	to	change	the	color	of	the	subject’s	shirt	to	more
of	teal	color	to	match	the	circles	in	the	background.	Using	the	top	drop-down	box,	we	can	select	Blues	to	try	and	target	the	blue	colors	in	the	shirt.	Once	you’ve	finished	defining	the	Layer	Mask,	you’re	done!	You’ve	successfully	changed	the	color	of	the	clothing	so	that	it	better	matches	the	background.	But	we’re	not	quite	done.	Let’s	take	a	look	at
another	technique	that	uses	the	Brush	Tool	to	remove	some	bright	colors	that	might	be	a	little	too	distracting.	Color	Change	with	the	Brush	Tool	Now	when	we	move	the	Hue	Slider,	the	blues	in	the	subject’s	clothing	change.	But	you’ll	also	notice	that	the	background	colors	change	as	well.	Don’t	worry	too	much	about	this,	as	we	can	use	a	Layer	Mask
to	prevent	the	Hue/Saturation	Adjustment	Layer	from	affecting	areas	that	we	don’t	want	it	to.	Fill	the	Layer	Mask	of	the	Hue/Saturation	Adjustment	Layer	with	black,	and	then	use	the	Brush	Tool	to	paint	white	on	the	Layer	Mask	where	you	want	the	color	change	to	appear–in	our	case,	the	subject’s	shirt.	The	Brush	Tool	&	Blending	Modes	You	can	also
change	the	color	of	almost	anything	in	a	photo	by	simply	painting	with	the	Brush	Tool	and	using	Blending	Modes	to	affect	the	color.	Sample	a	teal	color	from	the	background	and,	on	a	new	Layer,	paint	over	a	small	area	of	the	subject’s	bright	yellow	socks.	We’ve	got	the	color	we	want,	but	not	the	effect–it	clearly	looks	like	we	just	painted	over	the
fabric.	To	refine	the	effect,	we’ll	first	need	to	make	a	fairly	accurate	selection	of	the	areas	we	want	to	affect.	Since	we’re	targeting	the	only	bright	yellow	objects	in	the	image,	Select	Color	Range	is	the	perfect	tool	for	the	job.	Once	you’ve	got	a	selection	of	the	yellow	socks,	go	back	to	painting	over	them	with	that	sampled	teal	color.	Change	the
Blending	Mode	of	that	painted	Layer	to	Color,	and	you’re	good	to	go!	You	should	be	left	with	clothing	that	more	closely	matches	the	background,	and	a	more	cohesive	color	palette	overall!	Photography	is	not	just	a	hobby,	and	it’s	more	than	that.	Photography	has	become	a	form	of	art	through	which	a	photographer	tries	to	communicate	with	his	or	her
audience.	They	can	convey	thousands	of	pieces	of	information	without	saying	a	single	word.	This	is	the	power	and	impact	of	photography.	Besides	being	an	art	form,	photography	has	also	become	an	integral	part	of	business	ventures	nowadays.	Pictures	are	used	to	sell	services,	promote	businesses,	and	showcase	products	to	a	wider	audience.	Every
company	or	organization	wants	to	show	its	presence	through	digital	media,	mostly	images	of	their	businesses.	This	is	where	professional	photography	comes	into	play.	Professional	photography	has	become	an	attractive	career	opportunity	for	many	people.	In	recent	years,	this	industry	has	seen	gradual	growth,	which	has	made	professional
photography	a	viable	career	choice.	A	massive	market	is	based	around	photography,	and	the	number	of	people	entering	the	market	has	rapidly	increased.	A	study	carried	out	by	market	experts	came	up	with	some	interesting	numbers.	It	was	estimated	in	the	study	that	the	digital	photography	industry	globally	was	around	45	billion	USD	last	year.	This
is	estimated	to	increase	in	the	coming	years,	and	it’s	predicted	to	be	over	55	billion	USD	by	the	time	we	enter	the	next	decade.	More	than	30%	of	the	total	photography	market	worldwide	comes	from	commercial	photography,	according	to	a	study	conducted	last	year.	Since	2017,	the	industry	has	been	growing	at	a	rate	of	1.7–1.8%	per	year.	This	kind
of	number	and	growth	shows	the	potential	of	this	market	and	the	opportunities	to	explore	as	a	photographer.	With	the	growing	number	of	professional	photographers	entering	the	market	every	year,	the	competition	to	provide	quality	photography	to	clients	has	also	become	very	challenging.	Everyone	wants	to	make	a	splash	and	grab	viewers’
attention	with	their	work.	However,	this	is	not	always	the	case.	Most	of	the	time,	it	becomes	an	uphill	climb	for	photographers.	A	good	photographer	should	always	have	a	few	tricks	and	tips	up	their	sleeves	that	they	can	apply	to	stand	out	from	the	rest.	This	will	grab	the	attention	of	their	potential	clients	and	will	also	increase	their	exposure.	There’s
a	saying,	“A	photo	tells	more	than	a	thousand	words.”	This	is	also	true	when	you	are	trying	to	stand	out	and	make	your	space	in	this	industry.	You	need	to	be	able	to	take	eye-catching	pictures	to	create	a	buzz	around	your	work.	Capturing	the	perfect	image	is	not	an	easy	task	for	a	photographer.	There	are	so	many	factors	to	take	into	account	when
you	are	trying	to	click	a	photo.	So	any	kind	of	assistance	in	such	a	situation	is	a	blessing.	Photo	editing	is	a	blessing	for	you,	which	can	get	rid	of	much	of	your	stress	during	photo	shoots.	Photo	editing	is	typically	a	post-processing	procedure	used	to	remove	imperfections	from	an	image	that	occurred	during	a	photo	session.	Not	only	that,	but	you	can
also	make	many	additions	to	your	photo	to	enhance	the	quality	of	your	picture.	For	all	these	reasons,	it’s	so	important	now	for	a	photographer	to	know	picture	editing	for	his	own	sake.	Photo	editing	will	reduce	your	workload	and	save	you	valuable	time.	Photo	editing	will	give	you	that	extra	boost	to	your	image	to	enhance	its	quality.	Suppose	you	are	a
professional	photographer	for	a	client	who	is	a	designer,		a	model,	or	someone	from	the	fashion	industry.	One	day,	the	client	comes	to	you	and	asks	you	to	take	pictures	of	some	models	wearing	dresses	that	they	want	to	advertise	for	a	certain	company.	So,	as	usual,	you	take	pictures	of	the	models	wearing	the	dress	and	show	them	to	your	client.	Your
client	is	delighted	with	the	images	you’ve	clicked.	Now	they	want	to	make	some	modifications	and	want	you	to	change	the	color	of	the	dress	in	the	photo.	What	should	you	do	in	this	kind	of	situation?	These	are	the	times	when	Photoshop	comes	in	handy.	With	Photoshop,	you	can	easily	change	the	color	of	the	dress,	make	changes	in	the	brightness	or
contrast	of	the	dress,	and	so	on.	Now	that	you	know	why	you	need	it,	you	still	have	a	question.	“How	do	I	do	it?”	Don’t	you	worry!	This	article	has	the	solution	to	this	answer.	In	this	article,	I’ll	tell	you	how	to	change	the	dress	color	in	Photoshop	so	that	you	can	put	a	new	color	of	your	choice	on	the	dress	in	your	image.	The	dress	color	of	an	image	can
be	changed	using	various	computer	software	programs	during	the	post-processing	session.	Adobe	Photoshop	is	a	widely	used	software	program	for	editing	and	retouching	pictures	globally.	You	can	use	Photoshop	to	change	the	color	of	the	dress	in	a	picture.	Photoshop	can	also	be	used	to	change	the	brightness	and	contrast	of	the	dress	in	an	image.
All	of	these	topics	will	be	discussed	here	in	detail.	So,	I’d	suggest	you	go	through	the	article	to	the	end,	and	you	can	also	change	the	dress	color	of	your	pictures.	How	to	Change	Dress	Color	in	Photoshop?	I’ll	walk	you	through	the	process	of	changing	the	image’s	dress	color	in	Photoshop.	I’ve	taken	a	simple	image	of	a	shirt	for	this	tutorial	so	that	you
can	follow	the	steps	easily.	Once	you’ve	got	a	firm	grip	on	the	steps,	you	can	change	the	dress	color	in	complex	images.	First,	open	Adobe	Photoshop	on	your	computer.	Now,	select	File	and	again	select	‘Open.’	Browse	and	select	the	image	you	want	to	work	with.	You	can	do	the	same	by	dragging	and	dropping	your	photo	into	Photoshop	Canvas,	which
is	a	quicker	way	to	do	it.	After	you’ve	opened	the	targeted	photo	in	Photoshop,	you	will	see	on	the	right-hand	side	that	there’s	a	Background	layer.	Right-clicking	on	the	layer	to	select	‘Layer	from	Background’	will	open	a	new	tab.	Now	click	‘OK.’	You	can	also	rename	the	layer	in	this	step	before	clicking	‘OK’	if	you	want	to.	This	is	the	most	critical	and
time-consuming	step	of	this	process.	In	this	step,	you	are	going	to	select	the	dress	area	of	the	image	that	you	want	to	change	color.	In	Photoshop,	there	are	many	tools	that	can	be	used	to	select	an	object.	Some	of	them	are	automated,	and	others	are	manual.	I	recommend	you	use	the	manual	selection	tool	for	better	precision.	Some	manual	selection
tools	are:	Automated	tools	are	used	to	make	the	selection	in	a	photo	with	little	to	no	help.	But	the	Lasso	Tool	is	different	from	those	tools	as	it	requires	your	manual	input	to	make	the	selection.	The	Lasso	Tool	mainly	makes	selections	based	on	the	movement	of	your	mouse	cursor.	There	are	three	types	of	Lasso	Tools	in	Photoshop.	Apart	from	the
Primary	Lasso	Tool,	there	are	the	Polygon	Lasso	Tool	and	the	Magnetic	Lasso	Tool.	The	Polygon	Lasso	Tool	selects	an	area	by	drawing	a	straight	line	from	one	point	to	another.	This	works	much	faster	than	the	normal	Lasso	Tool.	The	Magnetic	Lasso	Tool	provides	you	with	automatic	assistance	near	the	edges	of	the	cursor.	It	works	based	on	color
contrast	and	makes	adjustments	accordingly.	It	is	faster	than	both	of	the	other	Lasso	Tools.	The	Lasso	Tool	is	sometimes	used	as	a	secondary	trimming	tool	after	using	one	of	the	automated	tools	primarily.	This	helps	make	the	selection	more	precise.	Just	like	the	Lasso	Tool	discussed	before,	the	Pen	Tool	is	also	used	for	making	a	selection	manually.
The	core	difference	between	these	two	tools	is	that	Pen	Tool	uses	a	vector-based	path	instead	of	pixel-based	one.	This	allows	for	resizing	without	taking	aliasing	into	account.	The	Pen	Tool	can	be	a	very	powerful	tool	for	you	once	you	master	it.	Mastering	the	Pen	Tool	is	worth	your	time,	as	it	helps	you	in	all	sorts	of	situations.	Be	patient	and	take	your
time	while	working	with	this	tool.	You	can	use	either	of	these	two	selection	tools	as	you	wish.	If	you	are	already	familiar	with	one	of	these	tools,	then	it’s	better	to	go	with	that	tool.	Otherwise,	go	with	any	tool	you	want.	Once	you’ve	made	the	selection,	you	may	want	to	apply	the	Brush	Tool	to	make	necessary	adjustments	to	the	edges	of	the	selected
area.	This	will	eliminate	possible	errors	that	occurred	during	the	selection	and	make	the	edges	of	the	selected	area	smoother.	Use	the	B	keyboard	shortcut	key	to	select	the	Brush	Tool.	The	alternate	way	to	select	the	Brush	Tool	is	to	select	it	from	the	toolbar	on	the	left-hand	side.	After	you’ve	applied	the	Brush	Tool,	you	need	to	adjust	the	hue	and
saturation	first.	This	is	the	step	where	you	are	going	to	change	the	color	of	the	selected	area.	Hue/Saturation	lets	the	user	adjust	the	hue,	saturation,	and	lightness	of	a	certain	range	of	colors	in	a	photo	or	adjust	all	the	colors	in	a	photo	simultaneously.	This	adjustment	allows	for	fine-tuning	colors	in	a	CMYK	photo	so	that	they	are	within	the	gamut	of
the	output.	Set	a	proper	value	for	Lightness,	Hue,	and	Saturation.	This	will	vary	from	image	to	image.	Experiment	with	it	with	different	values	and	settle	on	the	one	you	think	is	the	most	appropriate.	You	can	change	these	values	by	moving	the	slider	from	left	to	right	or	vice	versa.	Click	on	the	Image,	select	Adjustments,	and	again	select
Hue/Saturation.	You	can	also	do	this	from	the	‘Create	new	fill	or	adjustment	layer	button’.	This	is	located	below	the	layers	panel.	Once	you	have	selected	the	Hue/Saturation,	a	new	tab	will	open.	Check	the	Colorize	and	move	the	slider	as	per	your	requirement.	You	may	need	to	play	with	the	sliders	a	bit	to	get	your	desired	output.	If	you	are	only
looking	to	change	the	brightness	of	the	dress	area,	you	don’t	need	to	check	the	Colorize.	When	you	are	happy	with	your	adjustments,	select	Ok.	Save	the	image	file,	and	you	are	finished	with	the	edits.	Once	you’ve	changed	the	dress	color,	you	can	repeat	the	same	steps	to	change	the	color	again	and	again.	Save	your	changes	for	each	case,	leaving	you
with	multiple	copies	of	the	same	image	with	different	colors.	Now	that	I’ve	discussed	with	you	changing	dress	color	in	your	photos	easily	in	Photoshop	in	detail,	it	is	safe	to	assume	that	you	have	a	very	good	idea	about	these	concepts.	You	only	need	to	follow	these	steps	to	perfectly	change	the	dress	color	in	your	pictures.	You	need	to	understand	that
you	won’t	be	able	to	change	the	color	of	the	dress	with	absolute	perfection	from	the	get-go.	You	would	require	some	practice	before	getting	used	to	this.	Trial	Now!	changing	dress	color	Again,	this	is	not	the	only	way	to	change	the	dress	color	in	photos.	If	you	go	online,	you	will	find	hundreds	of	tutorials	and	guides	that	do	the	same	thing	using
different	methods.	But	if	you	look	closely,	more	than	90	percent	of	the	steps	are	similar	in	all	of	them.	So	if	you	can	follow	through	with	this	procedure	that	I’ve	discussed,	I	can	assure	you	that	you	will	come	back	with	fabulous	photos	that	will	grab	people’s	attention.	If	you	still	face	challenges	and	require	any	help	with	your	photos	to	changing	your
dress	color,	you	can	always	get	assistance	from	Clipping	Path	CA.	The	Clipping	Path	CA	is	world-leading	outsourcing	image	editing	and	pro	photo	editing	company	based	in	Canada.	They	help	you	grow	your	business	and	ROI.	They	expertly	handle	your	photo	editing	solutions	in	a	timely	and	cost-effective	manner.	They	have	helped	thousands	of	clients
worldwide	and	here	in	North	America.	Nine	out	of	ten	people	who	have	used	their	service	have	recommended	them.	Clipping	Path	CA	is	a	professional	photo	editing	and	retouching	company.	They	have	120+	expert	designers	of	their	own.	They	can	provide	photo	touch-up	services	to	clients	who	have	difficulty	touching	up	their	photos.	Clipping	Path
CA	is	a	photographer-friendly	platform	that	provides	services	at	a	reasonable	price	and	with	a	quick	turnaround	time.	Client	satisfaction	and	happiness	are	always	kept	in	mind.	Photo	Retouching	is	a	service	that	makes	images	perfect	and	flawless	and	makes	them	attractive	with	Photoshop	Service	by	changing	dress	colors	from	the	photos.	It	is	one	of
the	most	demanding	services	in	photo	editing	services.	Images	become	more	appealing	and	focused	with	the	addition	of	photo	retouching.	Questions	and	Answers	for	Edit	Photo	Dress	Yes,	you	can.	The	color	of	the	dress	can	be	changed	easily	from	the	photo	using	photo	editing	software	programs.	The	steps	that	should	be	followed	in	Photoshop	are
discussed	in	this	article.	When	you	are	new	to	this	type	of	editing,	it	may	take	time	to	change	the	dress	color	of	a	single	image	(around	10–15	minutes).	But	once	you’ve	had	some	experience	with	background	removal,	you	can	work	very	quickly	(in	7–8	minutes).	Some	images	will	take	more	time	than	usual	if	they	have	more	edges	and	curves.	Yes,	there
are	apps	that	can	change	the	color	of	the	dress.	Some	of	these	apps	are:➜	YouCam	Makeup➜	Facetune	Editor➜	Picsart➜	Recolor	Dress	&	Clothes	Colour➜	Change	Dress	and	Clothes	Color	Want	to	find	out	how	to	change	color	of	clothes	in	Photoshop?	I	have	described	a	simple	method	that	even	total	newbies	can	understand.	In	the	tutorial,	I	presented
different	tools	that	you	can	use	to	cope	with	the	task	without	distorting	colors	and	light	&	shadow	interplay.	Open	Photoshop	and	import	your	photo.	You	can	do	it	by	clicking	Open	or	by	creating	a	new	layer	and	dragging	&	dropping	a	picture	there.	Click	Layer	>New	Adjustment	Layer”	>	Hue/Saturation.	Or,	you	can	click	the	Hue/Saturation	icon	in
the	Adjustments	panel.	Choosing	any	of	these	methods,	you	will	create	the	Hue/Saturation	Adjustment	layer.	Adding	a	new	layer	through	the	menu	is	more	convenient	as	you	can	immediately	name	it	the	way	you	want.	So,	you	can	instantly	locate	it	on	the	Layers	panel.	Once	done,	click	OK.	When	editing	photos	of	clothes,	it	is	important	to	remove
clothing	wrinkles	in	Photoshop	before	you	proceed	with	changing	colors.	Thus,	you	will	prevent	possible	problems	with	textures	and	shadows.	Open	the	Properties	panel	located	above	the	Layers	panel.	It	may	be	inactive,	so	you	need	to	open	“Window”	>	Properties.When	editing	photos	of	clothes,	it	is	important	to	remove	clothing	wrinkles	in
Photoshop	(How	To	Remove	Clothing	Wrinkles	In	Photoshop	Tutorial)	before	you	proceed	with	changing	colors.	Thus,	you	will	prevent	possible	problems	with	textures	and	shadows.Open	the	Properties	panel	located	above	the	Layers	panel.	It	may	be	inactive,	so	you	need	to	open	“Window”	>	Properties.	Once	you	are	on	the	Hue/Saturation	panel,	you
can	change	clothes	color	Photoshop.	Click	the	color	channel	to	open	the	drop-down	menu.	You	will	see	different	options	in	the	list.	The	Master	option	is	chosen	by	default.	To	get	the	most	accurate	result	when	you	change	a	color	of	an	object	in	Photoshop,	select	the	finger	icon	with	two	arrows	on	the	sides.	Then	click	on	the	color	on	the	image	you
want	to	select.	I	click	on	the	dress	in	the	sample	photo.	When	the	color	is	selected,	the	entire	color	group	will	change	automatically.	You	can	skip	this	step	if	you	have	made	the	selection	around	the	clothing	item,	which	you	want	to	recolor.	If	you	haven’t,	it	is	necessary	to	move	the	Hue,	Saturation,	and	Lightness	sliders	till	you	get	the	desired	color.
Well	done!	Now	you	know	how	to	change	color	of	clothes	in	Photoshop.	You	can	experiment	with	colors	if	you	want.	If	you	still	need	some	time	to	grasp	the	process,	don’t	worry.	You	can	get	in	touch	with	skilled	retouchers	from	FixThePhoto,	who	will	take	care	of	your	images	while	you	are	learning	all	intricacies.	You	can	easily	cope	with	the	problem
by	using	masking	in	Photoshop.	Just	outline	the	clothing	item	that	you	want	to	recolor	and	apply	a	mask	from	the	Hue/Saturation	layer	to	it.Chose	the	color	you	want	to	change	and	close	the	Adjustment	Layer	window.	Select	the	adjustment	layer	mask	(white	square)	and	press	Ctrl	+	I.	The	mask	is	inverted	to	black,	and	all	our	changes	will	be
concealed.In	the	Adjustments	panel,	choose	the	tool	for	making	a	specific	correction.	For	instance,	select	Levels	or	Curves	to	correct	tone	and	color.	Click	Color	Balance	or	Hue/Saturation,	to	alter	colors.No.	There	are	different	programs	and	apps	you	can	use	to	cope	with	the	task.	However,	Ps	is	the	most	feature-rich	software,	so	the	result	will	be
more	professional	if	you	use	it.If	you	want	to	change	clothes	color	Photoshop,	I	recommend	using	JPEG	files.	However,	you	can	also	import	and	edit	TIFF	and	PNG	images.	Following	different	Photoshop	tutorials,	you	can	perform	different	manipulation	with	your	pictures.	In	case,	you	want	to	expedite	your	photo	editing	workflow,	you	should	try	pre-
made	Photoshop	effects.	With	them,	you	can	make	colors	in	your	images	brighter,	as	well	as	improve	shadows	and	exposure.	Changing	the	color	of	a	dress	in	Photoshop	can	enhance	your	images	and	add	creativity	to	your	projects.	This	tutorial	will	guide	you	through	the	process	step-by-step.##	Step	1:	Set	Up	Your	Document1.	**Launch	Photoshop**:
Start	by	launching	Adobe	Photoshop	on	your	computer.2.	**Open	Your	Image**:	Go	to	File	>	Open	and	select	the	image	of	the	dress	you	want	to	change	the	color	of.	Click	**Open**.##	Step	2:	Select	the	Dress1.	**Select	the	Quick	Selection	Tool**:	Select	the	**Quick	Selection	Tool**	from	the	toolbar	on	the	left	or	press	**W**	on	your	keyboard.2.
**Make	the	Selection**:	Click	and	drag	over	the	dress	to	create	a	selection.	The	Quick	Selection	Tool	will	automatically	detect	the	edges	of	the	dress.3.	**Refine	the	Selection**:	Go	to	Select	>	Select	and	Mask	(or	press	**Ctrl	+	Alt	+	R**	on	Windows	or	**Cmd	+	Option	+	R**	on	Mac).	Use	the	tools	in	the	Select	and	Mask	workspace	to	refine	the
edges	of	the	selection.You	can	checkout	the	layersClick	**OK**4.	It	will	get	back	to	the	image	with	dress	selected##	Step	3:	Create	a	Hue/Saturation	Adjustment	Layer1.	**Add	Adjustment	Layer**:	With	the	selection	active,	go	to	Layer	>	New	Adjustment	Layer	>	Hue/Saturation.2.	**Adjust	Hue**:	In	the	Properties	panel,	adjust	the	**Hue**	slider	to
change	the	color	of	the	dress.	You	can	also	adjust	the	**Saturation**	and	**Lightness**	sliders	to	fine-tune	the	color.3.	Similarly	fix	the	top	of	the	dress##	Step	4:	Fine-Tune	the	Color	Change1.	**Mask	Refinement**:	If	the	color	change	affects	other	parts	of	the	image,	refine	the	mask.	Click	on	the	mask	thumbnail	in	the	Layers	panel,	then	use	the
**Brush	Tool**	(B)	with	black	and	white	colors	to	paint	on	the	mask	and	hide/reveal	parts	of	the	adjustment.2.	**Adjust	Layer	Opacity**:	If	the	color	change	is	too	intense,	adjust	the	opacity	of	the	Hue/Saturation	layer	to	achieve	a	more	natural	look.##	Step	5:	Save	Your	Image1.	**Save	Your	Work**:	Go	to	File	>	Save	As	to	save	your	image.	Choose	a
format	that	suits	your	needs,	such	as	JPEG	or	PNG.2.	**Choose	File	Format**:	In	the	Save	As	dialog	box,	choose	the	desired	file	format	from	the	Format	dropdown	menu	and	click	**Save**.3.	**Complete	the	Save**:	In	the	options	dialog	box	that	appears,	adjust	any	necessary	settings	and	click	**OK**.—	-By	following	these	detailed	steps,	you	will	be
able	to	effectively	change	the	color	of	a	dress	in	Photoshop.	Each	step	includes	a	clear	description	and	corresponding	images	to	help	you	visualize	the	process.—	-Final	result


